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About This Guide

This document contains information on the following:

Chapter 1, “Overview,” on page 9
Chapter 2, “Accessing The Personal Management Utility,” on page 13
Chapter 3, “Working With Applications,” on page 15
Chapter 4, “Working With My Login,” on page 31
Chapter 5, “Working With Preferences,” on page 35
Chapter 6, “Working With Password Policies,” on page 47
Chapter 7, “Using the Advanced Menu,” on page 53

Audience

This guide is intended for the end users of Novell SecureLogin.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to the Novell Feedback Web site (http://www.novell.com/
documentation/feedback.html) and enter your comments there.

Documentation Updates

For the most recent version of the Novell SecureLogin 6.1 SP1 User Guide, visit the Novell 
Documentation Web site (http://www.novell.com/documentation/securelogin61/index.html).

Additional Documentation

This User Guide is a part of the documentation set for Novell SecureLogin 6.1 SP1. Other 
documents are:

Novell SecureLogin 6.1 SP1 Installation Guide
Novell SecureLogin 6.1 SP1 Administration Guide
Novell SecureLogin 6.1 SP1 Application Definition Guide
Novell SecureLogin 6.1 SP1 Citrix and Terminal Services Guide
Quick Start: “NMAS Login Method and Login ID Snap-In for pcProx”
Readme. Available online at the Novell Documentation Web site. (http://www.novell.com/
documentation/securelogin61sp1/index.html)

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.
About This Guide 7
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1Overview

Novell® SecureLogin is a Single Sign-on (SSO) product. It eliminates the necessity for users to 
remember multiple usernames and passwords. It stores usernames and passwords and automatically 
retrieves them for users when required. 

Novell SecureLogin consists of multiple, integrated security systems that provide authentication and 
single sign-on to networks and applications. 

This release of Novell SecureLogin runs on Microsoft* Windows Vista* as well as Windows* 2000 
and XP so, migrating to Vista is transparent to users and deployment is easy for administrators. 

Novell SecureLogin has wizards, an iManager plug-in, and tools that make it easy to centrally 
configure for use on the corporate network.

It supports usernames, passwords, and multi-factor authentication such as smart cards, tokens, or 
biometrics at the network and application levels.

In this document, we take a menu-oriented approach in explaining how to use the Personal 
Management utility to customize Novell SecureLogin to your preferences and requirements. 

1.1  Management Utilities
Novell SecureLogin has two management utilities:

Section 1.1.1, “Administrative Manage Utilities,” on page 9
Section 1.1.2, “The Personal Management utility,” on page 11

1.1.1  Administrative Manage Utilities
The Administrative Management utility

Administrators use the Administrative Management utilities: iManager SSO plug-in, SecureLogin 
Manager, and Active Directory* Computer Users and Snap Ins to define the settings and preferences 
of Novell SecureLogin for use by the end users.
Overview 9
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Figure 1-1   iManager: One of the Administrative Management Utilities
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Figure 1-2   The SecureLogin Management

1.1.2  The Personal Management utility
You can use the Personal Management utility to customize the Novell SecureLogin to suit your 
requirements. For example, you can set your own passphrase question and answer, and set your own 
password policies.

Figure 1-3   The Personal Management Utility
Overview 11
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2Accessing The Personal 
Management Utility

The Personal Management utility is represented by an icon  in the notification area (system tray).

To launch Novell® SecureLogin:

1 Click Start > Programs > Novell SecureLogin.

After you successfully launch the Novell SecureLogin, the  appears in the notification area.

Double-click this icon to launch the Personal Management utility. 

This icon is a shortcut the Novell SecureLogin functionality on your workstation.

1 Right-click the Novell SecureLogin icon in the notification area.
2 Select the task you want to perform. 

For example, select Add Applications to add, delete, and manage the applications.

Figure 2-1   The Advanced Preferences

The following table provides the information on the tasks available in the menu. If a task does 
not appear in the menu, your administrator has not enabled this functionality for you.

Option Description

Add Application Starts the Add Applications wizard. Enables an 
application for single-sign on by creating a script 
that automates the login.

Manage Logins Launches the Novell SecureLogin Personal 
Management utility.

Adds login IDs (login credentials), links login IDs 
to applications, manages password policies, and 
manages Novell SecureLogin settings.
Accessing The Personal Management Utility 13
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New Login Enables you to create multiple single sign-ons or 
login IDs for an application. For example, if you 
have three accounts on the same application, 
SecureLogin manages the three sets of 
credentials. 

SecureLogin provides the option to select the 
preferred account when the application starts. 

Advanced > Change Preferences Opens the Personal Management utility, with the 
Preferences option selected.

Advanced > Change Passphrase Enables you to change your passphrase 
question or passphrase answer.

Advanced > Refresh Cache Refreshes the local cache settings and updates 
caches with any changes made at the 
associated container or organizational unit level.

Advanced > Backup User Information Backs up the Novell SecureLogin user 
information into a file.

Advanced > Restore User Information Restores Novell SecureLogin information from 
the backup file.

Advanced > Work Online / Offline Toggles between the online and offline states of 
SecureLogin. When you work offline, 
SecureLogin uses the local (secondary) cache 
rather than the directory. 

This option is not displayed in Standalone mode

Active Determines whether SecureLogin is enabled 
(active) or disabled. 

About Displays the SecureLogin version number and 
the status of the data stores. The primary data 
store is the directory. The secondary is the local 
cache. 

Log User Off Windows Enables you to shut down all programs, 
including SecureLogin, and log out from the 
workstation. Performs the same function as the 
Shut Down > Log Off option on the Windows 
Start menu. 

Close Shuts down SecureLogin.

Option Description
 SecureLogin 6.1 SP1 User Guide
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3Working With Applications

Novell® SecureLogin uses application definitions to automatically log you in to Windows, Web, or 
Java applications. (An application definition is a set of instructions telling SecureLogin how to 
handle the login for a certain application.) Novell SecureLogin has predefined application 
definitions for some of the applications. You can use the Add Applications wizard to create new 
application definitions. 

The wizard captures and stores your login name (username), password, and any other information 
required for authentication.

Section 3.1, “Using the Add Application Wizard to Enable an Application for Single Sign-on,” 
on page 15
Section 3.2, “Using the Personal Management Utility to Enable Applications for Single Sign-
on,” on page 25
Section 3.3, “Using a New Application Definition to Enable Applications for Single Sign-on,” 
on page 26
Section 3.4, “Modifying an Application,” on page 27
Section 3.5, “Deleting an Application,” on page 28
Section 3.6, “Responding to Pop-Up Prompts,” on page 28

3.1  Using the Add Application Wizard to Enable 
an Application for Single Sign-on

Section 3.1.1, “Enabling Applications that Have a Predefined Application Definition,” on 
page 16
Section 3.1.2, “Enabling a Windows Application,” on page 17
Section 3.1.3, “Enabling a Web Application,” on page 21
Section 3.1.4, “Enabling a Java Application,” on page 23

When you launch an application for the first time and Novell SecureLogin is active on your 
workstation, a pop-up prompts you to enable single sign-on for the application. After you respond to 
the pop-up and allow SecureLogin to capture your login credentials, you are logged in automatically 
and the prompt does not appear again for this application.

If you are not prompted, use the Add Application wizard to enable the application for single sign-on. 
The wizard creates application definition that captures your login credentials. The next time you 
launch the application, Novell SecureLogin uses the application definition to automatically log you 
in.

Section 3.1.1, “Enabling Applications that Have a Predefined Application Definition,” on 
page 16
Section 3.1.2, “Enabling a Windows Application,” on page 17
Section 3.1.3, “Enabling a Web Application,” on page 21
Section 3.1.4, “Enabling a Java Application,” on page 23
Working With Applications 15
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3.1.1  Enabling Applications that Have a Predefined Application 
Definition
Application definitions store certain login information so that it can be used again and again. To save 
you the time and trouble of setting up application definitions, Novell SecureLogin provides 
predefined application definitions for many applications. 

To enable an application that has a predefined application definition:

1 Right-click the Novell SecureLogin  in the notification area (system area), then click Add 
Application. This launches the Add Application wizard.

2 In the Welcome to SecureLogin window, click Next.
3 On the Single Sign-on Enable an Application page, select Predefined Application, then click 

Next.
 SecureLogin 6.1 SP1 User Guide
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4 From the Predefined Application list, select an application, then click Next.
The next time you launch the application you selected, Novell SecureLogin prompts to specify 
the login credentials. 
Specify the credentials (the username and password), then click OK. This data is your login ID. 
Novell SecureLogin saves this data and automatically logs you in the next time you launch the 
application. 

3.1.2  Enabling a Windows Application
The following steps apply when Novell SecureLogin does not automatically detect a new 
application. If Novell SecureLogin detects a new application and launches the Add Application 
wizard, go to Step 7. 

1 Launch the Windows application for which you want to enable single sign-on.
2 Specify the username and password, but do not click OK, Next, or Finish. 

Keep the login dialog box open so that Novell SecureLogin can capture the information from 
the panel and save it appropriately.

3 Right-click the Novell SecureLogin  in the notification area, then click Add Application. 
This launches the Add Application wizard.
Working With Applications 17
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4 On the Welcome to SecureLogin page, click Next.
5 On the Single Sign-on Enable an Application page, select Windows Application, then click 

Next.

6 Drag the hand icon from the wizard page to the title bar of the login dialog box.
 SecureLogin 6.1 SP1 User Guide
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7 On the Select Window Function page, select Login Window from the drop-down list, then click 
Next.

8 Drag the hand icons and drop them onto the corresponding Username, Password, and (if 
appropriate) Other fields in the login dialog box.
Working With Applications 19
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9 Drag the hand icon for the OK button and drop it onto the OK, Next, Continue, or similar 
options on your login dialog box.

10 Click Next.
11 (Optional) In the Name the Application Definition dialog box, specify a name for the 

application definition. An appropriate default name is already suggested.

12 Click Finish.
 SecureLogin 6.1 SP1 User Guide
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3.1.3  Enabling a Web Application
1 Right-click the Novell SecureLogin  in the notification area, then click Add Application. 

This launches the Add Application wizard.

2 On the Welcome to SecureLogin window, click Next.
3 On the Single Sign-on Enable an Application page, select Web/Internet Application, then click 

Next.
Working With Applications 21



22 Novell

novdocx (en)  13 M
ay 2009
4 In the Single Sign-on Enable a Web/Internet Application dialog box, specify the URL of the 
Web page for which you want to enable single sign-on, then click Finish.

The Web page is launched.
5 Specify your username and password as login credentials.
 SecureLogin 6.1 SP1 User Guide
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6 You are prompted to save your credentials for single sign-on. Click Yes.

Novell SecureLogin extracts the login information from the Web page and stores it for future 
single sign-on authentication.

3.1.4  Enabling a Java Application
If Java applications are coded in AWT or Swing, Novell SecureLogin can enable those applications 
for single sign-on.

An application definition requires control numbers (hidden numbers that differentiate a Username 
edit box from a Password edit box). Determining the correct control numbers in a Java application 
might require trial and error. Therefore, we recommend that the network administrator configure 
Java applications centrally, test the applications, and then distribute them.

This section contains the following information:

Prerequisites

Install a Sun* Java Runtime Environment Version 1.4 or later. (Microsoft Java Virtual Machine 
is not supported.)
Select the option for enabling Java applications during Novell SecureLogin installation.
In the Preference Properties table, ensure that the value for Add application prompts for Java 
applications is set to Yes.
In the Preference Properties table, ensure that the value for Allow single sign-on to Java 
applications is set to Yes.
Working With Applications 23
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Figure 3-1   Enabling the Java Preferences

Adding the Java Application to the List of Applications

1 Launch the Java application.
If Novell SecureLogin is active on your workstation, it displays the following message:

2 Click Yes.
Novell SecureLogin extracts and stores the Java control information for login to the application 
or server.

3 Double-click the Novell SecureLogin  icon in the notification area, then select 
Applications.
Novell SecureLogin displays a new icon (Java) and application type.

4 Double-click the Java application, then click Definition.
5 Modify the application definition by typing the commands and control numbers that enable 

Novell SecureLogin to automatically log you in to the application.
Determining the control numbers might require trial and error.

6 Save the single-sign-on information by clicking Apply.
7 Test the Java application by launching it and logging in.
 SecureLogin 6.1 SP1 User Guide
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3.2  Using the Personal Management Utility to 
Enable Applications for Single Sign-on
You can enable an application for single sign-on through the Personal Management utility as well as 
through the Add Application wizard.

1 Double-click the Novell SecureLogin icon  in the notification area. This launches the 
Personal Management Utility with the Application menu selected.

2 Click . Alternatively, select File > New > Application. The New Application dialog 
box appears. 

3 From the Predefined Application Definition list, select the appropriate application definition. 
4 Click OK. Details of the selected application appear.
5 On the Details page, specify the username and password of the application.
Working With Applications 25
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6 (Optional) Click the Settings tab and define your preferences. 
7 Click Apply to apply the new login details.
8 Click OK to save and exit.

3.3  Using a New Application Definition to Enable 
Applications for Single Sign-on

1 Double-click the Novell SecureLogin icon  in the notification area. This launches the 
Personal Management utility with the Application menu selected.

2 Click Alternatively, select File > New > Application. The New Application dialog box 
appears. 

3 Select New Application Definition.
 SecureLogin 6.1 SP1 User Guide
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4 From the Type drop-down list, select the type of application.
You can select:

Windows
Terminal Launcher
Startup
Java
Generic
Advanced Web
Web wizard Script

5 Specify other details such as the name, the URL, executable, and description as required.
6 Click OK. 

You have successfully added an application. You now need to specify the credentials for the 
application.

7 From the Application navigation tree on the left pane, select the application you created.
8 Specify the username and password of the application.
9 (Optional) Specify the application definition of this application.

10 (Optional) Change the default settings to suit your requirements.
11 Click Apply. Your applications details are added to Novell SecureLogin.
12 Click OK to save and exit.

3.4  Modifying an Application
1 Double-click the Novell SecureLogin  icon in the notification area. 
Working With Applications 27
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2 In the Application navigation area on the left panel, select the application you want to modify.
3 Click . The Edit dialog box appears.

4 Make the required changes. You can modify the name, ID, and type of the application.
5 Click OK. The changes are saved.

3.5  Deleting an Application
1 Double-click the Novell SecureLogin  icon in the notification area. 
2 In the Application navigation on the left panel, right-click the application you want to delete.
3 Click Delete. The selected application is deleted.

3.6  Responding to Pop-Up Prompts
After Novell SecureLogin is installed on your desktop, Novell SecureLogin watches for applications 
that are not enabled for single sign-on. Upon detecting such an application, Novell SecureLogin 
prompts you to use a wizard to enable those applications for single sign-on and thereby simplify 
future logins.

Section 3.6.1, “Responding to Windows Application Prompts,” on page 28
Section 3.6.2, “Responding to Web Application Prompts,” on page 29
Section 3.6.3, “Responding to Prompts for Applications With Predefined Application 
Definition,” on page 29

3.6.1  Responding to Windows Application Prompts
After detecting a Windows login dialog box, Novell SecureLogin displays the following dialog box. 
(If the application has a predefined application definition, the initial text varies.)

Figure 3-2   Application Detection Prompt
 SecureLogin 6.1 SP1 User Guide
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You can choose not to enable single sign-on for this application. If you select Never, Novell 
SecureLogin generates a blank script for this application and does not prompt you again. If you 
select No, Novell SecureLogin prompts you the next time you launch the same application.

If you click Yes, Novell SecureLogin launches the Add Applications wizard, which guides you 
through the setup and creates a script for the login panel. The next time you open the application, 
Novell SecureLogin authenticates it for you.

3.6.2  Responding to Web Application Prompts
When you navigate to a Web page that has a login field and then submit your login information, 
Novell SecureLogin prompts you whether to enable single sign-on for the site, for only the current 
page, or not at all.

Figure 3-3   Prompts for Web Applications.

If you click Yes, Novell SecureLogin extracts the login information from the Web page and stores it 
for future single sign-on authentication.

3.6.3  Responding to Prompts for Applications With Predefined 
Application Definition
When Novell SecureLogin detects a login dialog box for an application that has a predefined 
application definition, Novell SecureLogin prompts you with the option to implement that 
application definition. 

The following figure illustrates a prompt for a Web site:

Option Description

Yes Creates an application definition, automatically reads the credentials entered into 
the browser, and stores the credentials against suitable variables. The next time the 
Web page is loaded, Novell SecureLogin enters your credentials.

Later Does not create an application definition. The next time the Web page is loaded, 
Novell SecureLogin displays the prompt again.

Never Creates a blank application definition with no variables. The next time the Web page 
is loaded, you are not automatically logged in or prompted to enable the Web page 
for single sign-on.

Options Allows you to view or hide both the description of the detected application and the 
Novell SecureLogin proceeds with login after entering your credentials check box. 
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Figure 3-4   Web Site Prompt

To enable the application definition, click Yes, then enter the required credentials. Novell 
SecureLogin logs you into the application whenever the application is launched.

To ignore the prompt, click No. The next time Novell SecureLogin detects the application’s login 
dialog box, Novell SecureLogin displays this prompt again, unless you create a new application 
definition for the application.
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4Working With My Login

My Login is a collection of sensitive information, such as your username and password. You can 
define a login so that two different applications can share the same login data. 

Through the My Login page, you can view and edit Novell SecureLogin user data, such as 
usernames and passwords, that allow you to successfully log in to an application.

To use Novell® SecureLogin to automatically log you in to an application, you create a Login (set of 
credentials) and link it to that application. 

If you add an application that has a predefined application, you need to link the login to it. You can 
provide login variables the next time that you access the application. However, you do not need to 
add or create login for applications that you enabled for single sign-on in the following ways:

If you encountered a new application through a pop-up prompt and then used the Add 
Applications wizard to enable the application.
If you ran the Add Applications wizard and selected a Web Page or Windows Application 
option as the script type.

In these two cases, the Add Application wizard of Novell SecureLogin created the login while you 
were adding the application to the single sign-on functionality.

You can use the same login to log you in to more than one application.

Also, if you have multiple roles, you can set up multiple logins for the same application. For 
example, you might be a network administrator as well as a user. When you log in to the network as 
administrator and then launch an application, Novell SecureLogin prompts you to select a profile. 
After you select the administrator profile, Novell SecureLogin then automatically logs you in with 
the appropriate credentials.

4.1  Creating a Login 
Section 4.1.1, “Creating the Login,” on page 31
Section 4.1.2, “Specifying the Credentials,” on page 32
Section 4.1.3, “Linking a Login to an Application,” on page 32

4.1.1  Creating the Login
1 Right-click the Novell SecureLogin  icon in the notification area, then click Manage 

Logins. 
or, 
Double-click the Novell SecureLogin  icon in the notification area. 
This launches the Personal Management utility.

2 Click My Logins > New.
3 Specify a name or ID in the Create Login dialog box, then click OK.
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You have now successfully created a new login. Repeat Step 1 on page 31 through Step 3 on 
page 31 to create other logins.
However, you need to specify the username and password to this login.
Repeat Step 1 through 4 to create other logins.

4 Continue with Section 4.1.2, “Specifying the Credentials,” on page 32 to specify the username 
and password for this login.

4.1.2  Specifying the Credentials
In the previous task, you created a login. Use the following steps to specify the credentials for your 
login,

1 In the My Login list in the left panel, select the login you created. The login page is displayed.
2 Select Username, then specify the username in the adjacent text field.
3 Select Password, then specify the password in the adjacent text field. The password is 

displayed as a series of asterisks. 
Select , it displays the actual password, instead of a series of asterisks.

4 Click Apply, then click OK. Your login credentials are saved.
Repeat Step 1 on page 32 through Step 4 on page 32 to specify the credentials to other logins.

4.1.3  Linking a Login to an Application
To add a newly created login to an application:

1 From My Logins, select the login that you want to link to an application.
2 Click . The Applications List window opens. 
3 Select the applications you want to link to this login. Click OK.
4 Click Apply, then click OK. The login information is saved.

4.2  Adding Multiple Logins
Section 4.2.1, “Prerequisites,” on page 32
Section 4.2.2, “Creating Another Login,” on page 33
Section 4.2.3, “Viewing The Additional Login,” on page 34
Section 4.2.4, “Testing The Multiple Logins,” on page 34

4.2.1  Prerequisites
Before you commence adding another login to an existing login, the first account must be 
enabled for single sign-on.
Before you add multiple logins to the first account, we recommend that you make a list of the 
usernames, passwords, and a unique name to identify the login.
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4.2.2  Creating Another Login
1 Right-click the Novell SecureLogin  icon in the notification area, then select New Login. 

The SecureLogin - Add New Login wizard welcome dialog box is displayed.

2 Select the required application.
3 Click Next. Click Next. A page displays where you can provide a description for the login.

4 In the Description field, specify a descriptive name for the login (for example, NSL 
Administrator).

5 Click Finish. A page appears where you can enter your credentials.
6 In the Username field, specify the username.
7 In the Password field, specify the password.
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8 Specify any additional variables as required.
9 Click OK to save your information and exit the Personal Management utility.

10 Repeat Step 1 on page 32 through Step 9 on page 34 to add any additional logins. When you 
have created all logins, you can view and manage them in the Personal Management utility.

4.2.3  Viewing The Additional Login 
1 Right-click the Novell SecureLogin  icon in the notification area, then select New Login. 

The SecureLogin - Add New Login wizard welcome dialog box is displayed.
2 In the navigation tree, select My Logins. The My Login page is displayed.
3 Verify that the additional login is added to the My Logins pane.
4 Click OK to close the Personal Management utility.

4.2.4  Testing The Multiple Logins 
1 Launch the application for which you added multiple logins.
2 Select the functionality you want to access. The login selection dialog box is displayed.
3 Select the appropriate login credential set.
4 Click OK. Novell SecureLogin enters the credentials and you are automatically logged in to the 

application.
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5Working With Preferences

The Preferences allow you to customize Novell® SecureLogin. Use this option to customize Novell 
SecureLogin to function in the way you want it.

The Administrator can also set the Novell SecureLogin user preferences in the Administrative 
Management utility. Each preferences has a default value until an alternative value is specified. 

NOTE: The preferences value set by you at the user object level overrides all higher level object 
values.

The list of preferences is a subset of the preferences that the administrator controls through the 
Administrative Management utility. If the Administrator has disabled a setting, you cannot use it or 
change it on your workstation. 

Section 5.1, “Viewing and Changing The Preferences,” on page 35
Section 5.2, “General Preference, Definitions, and Values,” on page 36
Section 5.3, “Java Preference, Definitions, and Values,” on page 44
Section 5.4, “Web Preferences, Definitions, and Values,” on page 44
Section 5.5, “Windows Preferences, Definitions, and Values,” on page 45

5.1  Viewing and Changing The Preferences
1 Click Preference. The preference properties table is displayed. 
2 Select the setting you want to customize. You can change the preferences for the following 

settings: 
“General Preference, Definitions, and Values” on page 36
“Java Preference, Definitions, and Values” on page 44
“Web Preferences, Definitions, and Values” on page 44
“Windows Preferences, Definitions, and Values” on page 45

3 From the drop-down list in the Value column, select the appropriate value. 
4 Click OK. 
5 Click Yes to save the settings and exit. 
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Figure 5-1   The User Preferences

5.2  General Preference, Definitions, and Values
Table 5-1   The General Preferences Properties Table

Preference Value Description

Allow "Close" option via 
system tray

Yes/No/Default If this option is set to Yes, the Close option is displayed in 
the notification area icon.

If this option is set to No or Default, the Close option is not 
displayed and accessible in the Novell SecureLogin 
notification area icon. 

The default value is No.

This preference is available only through the 
administrative management utilities.

Allow "Log Off" option via 
system tray

Yes/No/Default If this option is set to Yes the Log Off User option is 
displayed and accessible in the Novell SecureLogin 
notification area icon. 

If this option is set to No or Default, the Log Off User 
option is not displayed in the Novell SecureLogin 
notification icon.

The default value is No.

This preference is available only through the 
administrative management utilities.

Allow "Refresh Cache" 
option via system tray

Yes/No/Default If this option is set to Yes, the Refresh Cache option is not 
displayed and accessible in the notification area icon.

If this option is set to No or Default, the Refresh Cache 
option is displayed in the notification area icon.

The default value is No.

This preference is available only through the 
administrative management utilities.
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Allow "Work Offline" 
option via system tray

Yes/No/Default If this option is set to No or Default, the Work Offline option 
is displayed in the notification area icon.

If this option is set to Yes, the Work Offline options is not 
displayed in the notification area icon.

The default value is No.

This preference is available only through the 
administrative management utilities.

Allow application 
definition to be modified 
by users

Yes/No/Default If this option is set to Yes or Default, end user can view 
and modify their application definitions. 

If this option is set to No, the end user cannot change their 
application definitions.

The default option is Yes.

NOTE: Disabling this preference does not disable the 
users from creating new applications through the wizards.

This preference is available only through the 
administrative management utilities.

Allow application 
definition to be viewed 
by users

Yes/No/Default If this option is set to Yes or Default, users can view the 
application definition.

If this option is set to No, users cannot view the application 
definition.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow credentials to be 
deleted by users through 
the GUI

Yes/No/Default If this option is set to Yes or Default, users can delete their 
credentials through the GUI.

If this option is set to No, users cannot delete their 
credentials.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow credentials to be 
modified by users 
through the GUI

Yes/No/Default If this option is set to Yes or Default, users can modify their 
credentials through the GUI.

If this option is set to No, users cannot modify their 
credentials through the GUI.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Preference Value Description
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Allow users to (de) 
activate SSO via system 
tray

Yes/No/Default If this option is set to Yes or Default, users can switch 
between active and inactive modes of Novell SecureLogin. 

If this option is set to No, Novell SecureLogin is always 
active. User do not have the option to switch.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow users to backup/
restore

Yes/No/Default If this option is set to Yes or Default, users can back up 
and restore their single sign-on information. 

If this option is set to No, users cannot back up and restore 
their single sign-on configuration.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow users to change 
passphrase

Yes/No/Default If this option is set to Yes or Default, users can change 
their passphrase through the notification area icon.

If this option is set to No, the Change Passphrase option is 
not displayed and users cannot change their passphrase 
through the notification area icon.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow users to modify 
names of Applications 
and Logins

Yes/No/Default If this option is set to Default, Novell SecureLogin behaves 
as if it is set to Yes.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow users to view and 
change Preferences

Yes/No/Default If this option is set to Yes or Default, users can view and 
change their preferences.

If this option is set to No, users cannot view and change 
their preferences.

The default value is Yes.

NOTE: We recommend that you create a separate ou to 
ensure that they are not adversely affected by the general 
user configuration preferences at the ou level.

This preference is available only through the 
administrative management utilities.

Preference Value Description
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Allow users to view and 
modify API preferences

Yes/No/Default The API preference defines the following options for users 
to:

Enter an API licence key(s).

Provide API access.

If this option is set to Yes or Default users can view and 
modify the API preference.

If this option is set to No, users cannot view and modify the 
API preference.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Allow users to view 
passwords

Yes/Yes, per 
applications/No/
Default

if this option is set to Yes or Default, users can view their 
passwords.

If this option is set to No, users cannot view their 
passwords.

If this option is set to Yes, per application, users can view 
their passwords for only specific applications.

The default value is Yes.

NOTE: Allowing users to view their passwords gives them 
an opportunity to view and record passwords if they need 
to reset the Novell SecureLogin configuration.

This preference is available only through the 
administrative management utilities.

Change the cache 
refresh interval (in 
minutes)

5 This preference defines the time in minutes of the 
synchronization of the user data and directory on the local 
workstation.

The default value is set to 5 minutes.

However, depending on the network traffic and the number 
of users the interval can be set between 240 minutes and 
480 minutes (four and eight hours).

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Container has priority 
over User

Yes/No/Default If this option is set to Yes, the container settings has 
priority over user settings.

If this option is set to No or Default, the container settings 
does not have priority over the user settings.

The default value is No.

This preference is available only through the 
administrative management utilities.

Preference Value Description
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Detect incorrect 
passwords

Yes/No/Default If this option is set to Yes or Default, incorrect passwords 
for Web applications are detected.

If this option is set to No, incorrect passwords for Web 
applications are not detected.

The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Disable single sign-on Yes/No/Default If this option is set to Yes, access to Novell SecureLogin is 
disabled.

If this option is set to No or Default, access to Novell 
SecureLogin is enabled. 

The default value is No.

This preference is available only through the 
administrative management utilities.

Display splash screen on 
startup

Yes/No/Default If this option is set to Yes or Default, the splash screen 
appears when Novell SecureLogin startsup.

If this option is set to No, the splash screen is hidden and 
users cannot see the splash screen when Novell 
SecureLogin startsup.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Display the system tray 
icon

Yes/No/Default If this option is set to Yes or Default, the Novell 
SecureLogin icon appears on the notification area.

If this option is set to No, the Novell SecureLogin icon 
does not appear on the notification area.

The default value is Yes.

NOTE: When the Novell SecureLogin is active, users can 
double-click the icon on the notification area to launch the 
Personal Management utility.

When the Novell SecureLogin is inactive, user can start 
the Personal Management utility through Start > Programs 
> Novell SecureLogin > Novell SecureLogin

This preference is available only through the 
administrative management utilities.

Preference Value Description
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Enable cache file Yes/No/Default This options defines the enabling or disabling of the 
creation of a Novell SecureLogin cache file on the local 
workstation. The cache stores user configuration data: 
local and inherited.

Set this option to Yes for mobile users.

If this option is set to No, you cannot store files locally or 
you are have some conflicts with organizational security 
policy

If this option is set to Default, Novell SecureLogin behaves 
as if it is set to Yes.

The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Enable Logging to Novell 
Audit

Yes/No/Default This preference defines the enabling or disabling of log 
events to be automatically sent to Novell Audit.

The following ou or user objects are logged by NSure:

Single sign-on client started

Single sign-on client exited

Single sign-on client activated by user

Single sign-on client deactivated by user

Password provided to an application by a script

Password changed by the user in response to a 
change password command

Password changed automatically in response to a 
change password command

NOTE: The Novell Audit platform must be installed on the 
client with a registered application ID and schema file on 
the server.

If this option is set to Yes or Default, logging to Novell 
Audit is enabled.

If this option is set to No, logging to Novell Audit is 
disabled.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Preference Value Description
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Enable the New Login 
Wizard on the system 
tray icon

Yes/No/Default This preference defines the enabling or disabling the 
user’s ability to create multiple logins for different accounts 
on the same application or server.

If this option is set to Yes or Default, users can create 
multiple logins.

If this option is set to No, users cannot create multiple 
logins.

The default value is Yes.

This preference is available only through the 
administrative management utilities.

Enforce passphrase use Yes/No/Default Enforces the user definition of a passphrase question and 
answer when Novell SecureLogin is launched.

If this option is set to Yes, users must complete setting up 
their passphrase before they proceed with any other 
activity on the workstation.

If this option is set to No or Default, users can postpone 
setting up the passphrase.

The default value is No.

This preference is available only through the 
administrative management utilities.

Enter API license key(s) Specify API 
licence key(s)

Specify the API license key(s) provided by Novell 
SecureLogin to activate the API functionality for an 
application.

Password protect the 
system tray icon

Yes/No/Default Restricts the users from accessing the Novell SecureLogin 
icon menu option (from the notification area) without their 
network login password.

If this option is set to Yes, the Novell SecureLogin icon on 
the notification area is password protected.

If this option is set to No or Default, the Novell 
SecureLogin icon on the notification area is not password 
protected.

The default value is No.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Preference Value Description
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Provide API Access Yes/No/Default Enables or disables the API functionality.

If this option is set to Yes, the APII access is enabled.

If this option is set to No or Default, the API access is 
disabled.

The default value is No.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Standalone distributed 
settings have priority 
over user’s

Yes/No/Default Allows or disallows the values of configuration settings 
made by user to take precedence over the configuration 
settings made after settings distribution.

Use this preference in advanced standalone mode for 
overwriting locally applied scripts, settings, and credentials 
by centrally created credentials.

Use this preference also for suers who receive the 
encrypted and signed settings.

If this option is set to Yes, the standalone distributed 
settings have priority over user’s settings.

If this option is set to No or Default, the standalone 
distributed settings do not have priority over user’s 
settings.

The default value is No.

This preference is available only in SecureLogin Manager.

Stop walking here Yes/No/Default Enables or disables the inheritance of settings from higher 
level containers or organizational units.

If this option is set to Yes, the inheritance of settings from 
higher level containers or organizational units is disabled.

Set the option to Yes during phased upgrades when 
higher levels might have a different version of Novell 
SecureLogin implemented.

If this option is set to No or Default, the inheritance of 
settings from higher level containers or organizational 
units is enabled.

The default value is No.

This preference is available only through the 
administrative management utilities.

Preference Value Description
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5.3  Java Preference, Definitions, and Values
Table 5-2   The Java Preferences Properties Table

5.4  Web Preferences, Definitions, and Values
Table 5-3   The Web Preferences Properties Table

Preference Value Description

Add application prompts 
for Java applications

Yes/No/Default If the preference is set to Yes or Default, as soon as 
Novell SecureLogin detects a Java application login 
page, it prompts the user to record it.

If this option is set to No, this process never occurs, only 
Java predefined applications are prompted and 
supported

The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Allow single sign-on to 
Java applications

Yes/No/Default If the preference is set to Yes or Default, as soon as 
Novell SecureLogin detects a Java application login 
page, it prompts the user to enable it for single sign-on.

If this option is set to No, Java applications are not 
enabled for single sign-on.

The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Preference Value Description

Add application prompts 
for Internet Explorer

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Add application prompts 
for Mozilla Firefox

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Allow single sign-on to 
Internet Explorer

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.
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5.5  Windows Preferences, Definitions, and 
Values
Table 5-4   The Windows Preferences Properties Table

Allow single sign-on 
Mozilla Firefox

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Allow single sign-on to 
Netscape

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Preference Value Description

Add application prompts 
for Windows applications

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Allow single sign-on to 
Windows applications

Yes/No/Default The default value is Yes.

This preference is available in both the Personal 
Management utility and the administrative management 
utilities.

Preference Value Description
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6Working With Password Policies

Novell® SecureLogin provides the password policy functionality to enable you to effectively and 
efficiently manage your password.

Organizations and applications often have rules about the content of passwords, such as the required 
number of characters and type of characters. The Password Policies option in Novell SecureLogin 
Personal Management utility provides functionality to create and enforce these password rules 
through a Password policy, and apply this policy to one or more application logins.

Section 6.1, “Creating a Password Policy,” on page 47
Section 6.2, “Editing a Password Policy,” on page 51
Section 6.3, “Deleting a Password Policy,” on page 52

6.1  Creating a Password Policy
1 Double-click the Novell SecureLogin  icon in the notification area.
2 Click Password Policies, then click . The New Password Policy dialog box is 

displayed.

3 Specify a name for your password policy, then click OK.
You have now successfully created a new password policy, but you need to set your preferences 
for the password policy. These preferences are unique to you and are enforced on your 
workstation.

4 In the Password Policies navigation area, select the password policy you want to edit.
5 You can view and change the following settings:
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Policy Value To Be provided Description

Minimum length Whole number Defines the minimum length of the 
password; that is, the number of 
characters required for the password. 

Maximum length Whole number Defines the maximum length of the 
password; that is, the maximum number 
of characters allowed in password. 

Minimum punctuation 
characters

Punctuation 
characters

Defines the minimum number of 
punctuation characters allowed in a 
password.

Maximum punctuation 
characters

Punctuation 
characters

Defines the maximum number of 
punctuation characters allowed in a 
password.

Minimum uppercase characters Whole number Defines the minimum number of 
uppercase characters allowed in a 
password.

Maximum uppercase characters Whole number Defines the maximum number of 
uppercase characters allowed in a 
password.

Minimum lowercase characters Whole number Defines the minimum number of 
lowercase characters allowed in a 
password.

Maximum lowercase characters Whole number Defines the maximum number of 
lowercase characters allowed in a 
password.

Minimum numeric characters Whole number Defines the minimum number of numeric 
characters allowed in a password.

Maximum numeric characters Whole number Defines the maximum number of 
numeric characters allowed in a 
password.

Disallow repeat characters No/Yes/Yes, case 
insensitive

Disallows the use of repeated 
characters, or the use of the same 
successive characters.

If this option is set to No, characters can 
be repeated. This is the default value. 

If this option is set to Yes, same 
alphabetic characters in a different case 
are considered as different characters. 
For example, A and a are different.

If this option is set to Yes, case 
insensitive, the successive use of the 
same alphabetic characters in a different 
case is not allowed. 
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Disallow duplicate characters No/Yes/Yes, case 
insensitive

Disallows the use of the same non-
successive characters. 

If this option is set to No, duplicate 
characters are allowed. This is the 
default value. 

If this option is set to Yes, the same 
alphabetic characters in a different case 
are considered as different characters. 
For example, A (uppercase) and a 
(lowercase) are different.

If this option is set to Yes, case 
insensitive, duplication of the same 
alphabetic characters in a different case 
is not allowed. 

Disallow sequential characters No/Yes/Yes, case 
insensitive

Disallows the use of successive 
characters in an alphabetical order. 

If this option is set to No, sequential 
characters are allowed. This is the 
default value.

If this option is set to Yes, sequential 
characters in a different case are 
considered as non-sequential. For 
example, a and b and non-sequential. 

If this option is set to Yes, case 
insensitive, sequential characters in 
different cases is disallowed. 

Begin with an uppercase 
character

No/Yes Enforces the use of an uppercase 
alphabetic character as the beginning 
character of a password.

The default value is No.

If this option is set to Yes, all other 
policies that indicate that a password 
must begin with a particular character or 
in a specific manner are disabled.

IMPORTANT: Only one type of character 
can be designated as the first value of a 
password.

End with an uppercase 
character

No/Yes Enforces the use of an uppercase letter 
at the end of a password. 

The default value is No.

If this option is set to Yes, all other 
policies that indicate that a password 
must end with a particular character or in 
a specific manner are disabled.

Policy Value To Be provided Description
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Prohibited characters Keyboard characters Defines a list of characters that cannot 
be used in a password.

NOTE: There is no need of a separator 
in the list of prohibited characters. For 
example, @#$%&*

Begin with any Alpha character No/Yes Enforces the use of an alphabetic 
character at the beginning of a 
password. 

The default value is No.

If this option is set to Yes, it automatically 
disables all other policies that specify 
what the first character of the password 
should be.

Begin with any number No/Yes Enforces the use of a numeric character 
as the first character of the password. 

The default value is No. 

If this option is set to Yes, it automatically 
disables all other policies that specify 
what the first character of the password 
should be.

Begin with any symbol No/Yes Enforces the use of a symbol character 
as the first character of the password. 

The default value is No.

If this option is set to Yes, it automatically 
disables all other policies that specify 
what the first character of the password 
should be.

End with any Alpha character No/Yes Enforces the use of an alphabetic 
character as the last character of the 
password. 

The default value is No.

If this option is set to Yes, it automatically 
disables all other policies that specify 
what the password should end with.

End with any number No/Yes Enforces the use of a numeric character 
as the last character of the password. 

The default value is No.

If this option is set to Yes, it automatically 
disables all other policies that specify 
what the password should end with.

Policy Value To Be provided Description
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6 Click Apply. The settings are saved.

6.2  Editing a Password Policy
To edit an existing password policy settings:

1 Double-click the Novell SecureLogin icon in the notification area.
2 In the Password Policies navigation area, select the password policy you want to edit. The 

settings of the selected password policy are displayed.

End with any symbol No/Yes Enforces the use of a symbol character 
as the last character of the password. 

The default value is No.

If this option is set to Yes, it automatically 
disables all other policies that specify 
what the password should end with.

Policy Value To Be provided Description
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3 Select the setting you want to change. 
4 In the adjacent column, change the value of the settings as required. Refer to Section 6.1, 

“Creating a Password Policy,” on page 47 for the setting options and their descriptions.
5 Click Apply.

6.3  Deleting a Password Policy
1 Double-click the Novell SecureLogin  icon in the notification area.
2 In the Password Policies navigation area, right-click the password policy you want to delete, 

then click Delete.
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7Using the Advanced Menu

Use the Advanced menu to change your preferences, passphrase question and answer, refresh the 
cache, back up and restore information, and work online or offline.

Figure 7-1   The Advanced Menu

Section 7.1, “Changing Preferences,” on page 53
Section 7.2, “Creating a Passphrase,” on page 53
Section 7.3, “Changing a Passphrase,” on page 54
Section 7.4, “Refreshing the Cache,” on page 56
Section 7.5, “Backing Up User Information,” on page 57
Section 7.6, “Restoring User Information,” on page 58
Section 7.7, “Working Online and Working Offline,” on page 60

7.1  Changing Preferences
Through the Advanced > Change Preferences option, you can view and change the General, Java, 
Web, and Windows preferences.

The procedures and tasks that you perform are the same explained in the Section 5.1, “Viewing and 
Changing The Preferences,” on page 35.

7.2  Creating a Passphrase
The first time log in to your workstation and launch Novell® SecureLogin, you are prompted to set 
up your passphrase question and answer.

1 The Passphrase Setup dialog box is displayed.
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If your administrator has defined a set to question, you must select one of the questions and 
specify your answer.

2 In the Enter a question field, select or specify a passphrase question.
3 In the Enter the answer field, specify the new passphrase answer.
4 In the Confirm the answer field, retype the new passphrase answer.
5 Click OK. The changes are saved.

NOTE: If your administrator has changed the Security preference from Hidden to Yes, you are 
promoted to re-enter your passphrase question and answer. 

Specify your passphrase again (after the initial set up) to continue with the login.

7.3  Changing a Passphrase
Passphrases protect your credentials from unauthorized use. For example, in an Active Directory 
environment, you can potentially log in to the network by resetting the user’s network password. 
You can avoid such occurrences by using a passphrase. 

However, this cannot happen if you are using a Novell SecureLogin passphrase. If someone other 
than the actual user tries to reset the network, Novell SecureLogin triggers the passphrase question. 
The user must provide the correct answer before successfully logging in. 
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Even an administrator cannot access the user’s single sign-on-enabled applications without knowing 
the user’s passphrase answer.

1 Right-click the Novell SecureLogin icon in the notification area, then select Advanced > 
Change Passphrase. The Passphrase dialog box is displayed.

2 Specify the existing passphrase response in the field.
3 Click OK. The Passphrase Setup dialog box is displayed.

4 In the Enter a question field, select or specify a passphrase question.
5 In the Enter the answer field, specify the new passphrase answer.
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6 In the Confirm the answer field, retype the new passphrase answer.

7 Click OK. The changes are saved.

NOTE: If you do not have access to the Novell SecureLogin  icon in the notification area, you 
cannot change your passphrase answer. You administrator has disabled access to the Novell 
SecureLogin icon in the notification area.

7.4  Refreshing the Cache
The Novell SecureLogin cache is encrypted local copy of Novell SecureLogin data. It allows users 
who are not connected to the network, for example, if they are working offline or using a laptop, to 
continue using Novell SecureLogin even if the directory is unavailable. 

By default, a cache file is created on the workstation as part of the Novell SecureLogin installation. 
The cache file stores your data locally and is synchronized regularly with your data in the directory.

The directory and workstation caches are synchronized regularly, by default every five minutes.

To refresh the cache manually:

1 Right-click the Novell SecureLogin icon in the notification area, then select Advanced > 
Refresh Cache. 
The cache is refreshed and it is synchronized with the cache in the directory.
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7.5  Backing Up User Information
Because SecureLogin data is stored in the directory, existing directory backups also back up Novell 
SecureLogin data. In addition, the local cache synchronizes with the directory for further 
redundancy of data. 

Backing up or restoring by using the SecureLogin menu options is typically performed by users who 
have been disconnected from the network for long periods of time, such as weeks or months.

To create a backup file:

1 In the notification area, right-click the Novell SecureLogin icon, then select Advanced > 
Backup User Information. The Save Settings dialog box is displayed.

2 Select a folder where you want to store the backup file. 
The file can be stored in any location. 

3 In the File name field, specify a name for the backup file.
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4 Click Save. The Password dialog box is displayed.

5 In the Password field, specify a password.
6 Click OK. 

The encrypted and password-protected backup file is saved, and a confirmation message 
appears. 

7 Click OK.

7.6  Restoring User Information
IMPORTANT: Before restoring the backup file, you must delete the cache file on the workstation. 

7.6.1  Deleting the Workstation Cache
1 Right-click the Windows Start button, then click Explore.
2 Browse to the following directory: 

C:\Documents and Settings\[user]\Application Data\SecureLogin\Cache

Ensure that you have selected Show hidden files and folders in the Windows Folder Options 
dialog box.

3 Delete the cache directory.
4 Close Windows Explorer.
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7.6.2  Restoring the Backup File
To restore the user information from the local cache backup file:

1 In the notification area, right-click the Novell SecureLogin  icon, then select Advanced > 
Restore User Information. The Load Settings dialog box is displayed.

2 Select the backup file.
3 Click Open. The Password dialog box is displayed.

4 In the Password field, specify the password.
5 Click OK. 

A message appears, confirming that cache data has been loaded to the local workstation cache.
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6 Click OK.

7.7  Working Online and Working Offline
The Work Offline option stops the synchronization process with the directory, so Novell 
SecureLogin relies only on its local cache file or equivalent smart card. 

If this option is set to Yes in the Administrative Management utility by the administrator, the Work 
Offline option is not displayed on the notification area icon. 

Novell SecureLogin detects if it is online or offline and adapts its behavior accordingly. 

If this option is set to either No or Default, the Work Offline option is displayed and accessible in on 
the notification area icon.

To work offline:

1 In the notification area, right-click the Novell SecureLogin  icon, then select Advanced > 
Work Offline. 
The synchronization process with the directory stops.

To work online:

1 In the notification area, right-click the Novell SecureLogin  icon, then select Advanced > 
Work Online. 
You are now working online and the synchronization with the directory is active.
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